User Interface

The updated modernized User Interface (UI) in Autodesk® AutoCAD® 2016 software is easier to work with and reduces eye strain.

**Start Tab**

The Start tab (formerly the New tab) is filled with information and speedy ways for you to start new drawings or edit existing ones.

The Start tab contains two helpful sliding content frames: Learn and Create.

The Create page makes it easy for you to start a new drawing, access recent files, and connect with Autodesk® A360. Here you’ll find various notifications as well as where to download offline Help.

Use the icons at the bottom of the Recent Documents list on the Create page to switch from thumbnail to text view (or both).

The Learn page is filled with What’s New and Getting Started videos, and online resources. The Tip of the Day is updated every 24 hours (so be sure to check them out to improve your AutoCAD skills!).

Ctrl+Home or GOTOSTART gets you to the Start tab quickly.

**NOTE** The Start tab can be turned on/off for deployments.

The plethora of productivity tools in AutoCAD 2016 is certain to provide a better design experience for everyone!
**User Interface**

**TIP** Set STARTMODE to 0 if you don’t want the Start tab to display.

Right-click on a file tab to access the Close All Other Drawings option (or use the CLOSEALLOTHER command).

**Color Schemes**

Have you been staring at AutoCAD all day? Give your eyes a rest with the dark-themed interface.

**TIP** You can easily switch AutoCAD back to the more traditional light theme by setting the Color scheme control on the Display tab of Options or by setting COLORTHEME to 1.

**Status Bar**

Populate the Status bar with the tools you want by clicking on the three stacked lines (the “hamburger”) in the lower-right corner of the editor. Isolate Objects and Lock UI options have been added.

If you are new to AutoCAD, check out the Hitchhiker’s Guide to AutoCAD Basics!

**Help**

Can’t find a tool? Click on the Find link in the Help window and an animated arrow points to its location in the Quick access toolbar, ribbon, Status bar, and Application menu.

Use the Lock User Interface tool to check/uncheck multiple UI elements at one time. Click on the icon to quickly enable/disable locking.

The Status bar will automatically wrap onto two rows when the icons can’t fit into a single row.
Workspaces

Workspaces are no longer displayed by default in the Quick Access toolbar. You can still find them on the Status bar (who needs them in two places anyway?).

Galleries

The new block galleries make it easy to view and insert blocks from your current drawing directly from the ribbon.

You’ll also find helpful galleries for styles such as dimensions, mleaders, text, tables, and table cells.

Layouts

You’ll appreciate the layout preview thumbnails and the handy + symbol to quickly add a new layout. For those of you who like to heap on the layouts—you’ll like the overflow menu for easy access to layouts that extend to either side of the tabs. Drag and drop layout tabs anywhere, including the overflow.

Model Space Viewports

Model Space Viewports are easier to identify and easier to resize. Simply drag the horizontal or vertical viewport boundaries, or the intersection, to resize them.

The + icon lets you easily add more viewports … just drag it to the proper size.

TIP You can join or remove a viewport by dragging a boundary to the edge.

NOTE the Classic Workspace has been removed—time to get onboard with the ribbon!
Improved Graphics

Are you tired of the jagged diagonal lines in AutoCAD? AutoCAD 2016 to the rescue! The LINESMOOTHING variable smooths out lines (including those with lineweights) and curves at any zoom level.

Simply select the new “High quality geometry” option in the Graphics Performance dialog (easily found on the Status bar).

**NOTE** Hardware acceleration must be turned ON.

Set LINEFADING to 1 to automatically fade geometry as you zoom into super-dense drawings. Control the amount of fading with LINEFADINGLEVEL.

If your hardware doesn’t support **High quality geometry** (isn’t DirectX® 11-capable), try using the Smooth line display for better graphics performance.

3D Orbit

Enjoy better control of the target point when you turn off “Enable Orbit Auto Target” from the 3D Orbit right-click menu. Then you can click and hold the cursor to specify the pivot point.

A small spherical icon will display to indicate the pivot point.
Object Selection

We spend so much of our AutoCAD time selecting and editing objects—check out these handy additions:

Selecting Objects

When selecting objects, the geometry appears thicker and darker (or lighter, depending on your background color).

After you select objects, they change color and remain thickened, so you are certain you’ve selected the correct objects! (only if hardware acceleration is on).

Don’t like the new highlight? Set SELECTIONEFFECT to 0.

Customize the highlighting color on the Selection tab of Options (Selection effect color).

Moving objects will be clearer with the faded deletion effect. Both Move and Copy previews are super speedy!

Complex linetypes display true to form as you draw and edit them.

Set COMPLEXLTPREVIEW to 0 to turn this feature off.

Property preview performance is vastly improved with large selection sets.

Lasso Selection

Click and drag your cursor to use the versatile Lasso selection—click and release for the traditional rectangular selection.

The Command Preview control on the Selection tab of Options enables/disables this cool feature.

New object snap (GCE) finds the geometric center of polygons and closed polylines.

A new glyph indicates geometric center.

This behavior can be turned off on the Selection tab of Options.

Hit the spacebar to cycle between window, crossing and fence options.
Productivity Improvements

**Badges**
AutoCAD 2016 has added handy, relevant badges that provide you with contextual feedback right next to the crosshairs during selection, inquiring, and editing.

| Set CURSORBADGE to 1 to turn off the display of cursor badges (2 to turn them back on). |

| NOTE | The crosshairs have been removed from the inside of the pickbox to make it easier to see what you’re selecting. |

---

**Revision Clouds**
If you draw revision clouds, you’re going to love the updated REV CLOUD that supports rectangular, polygonal, and freehand (and Object from the command line). The new Revision clouds are easy to edit using grips (no more stretched, elongated arcs!).

| Use the Modify option to create an additional revision cloud and delete selected portions of an existing revision cloud (put more than one revision cloud together). |

| TIP | Set your preferred default with REV CLOUD CREATE MODE |

| NOTE | Set REV CLOUD GRIPS to Off to put grips back to legacy behavior. |

---

**Isometric Drafting Environment**
Use the Isodraft tool on the Status bar to switch the snap style to Isometric and move from one isometric plane to another.

---

**System Variable Monitor**
Tired of system variables being changed without you knowing about it? Use the new System Variable Monitor (SVARMONITOR) to quickly identify system variables that no longer conform to your standard.
You set up the variables and their preferred settings (although you’ll find some popular defaults already prepopulated). Turn on notifications to display at the command line, on the Status bar icon, or even enable a balloon notification should a variable on your monitored system variable list be changed.

Xref Enhancements
Control the display of layers from xref drawings (even if they’re not set to Bylayer in the host drawing). Set XREFOVERRIDE to 1 and xref objects will take on Bylayer behavior.

NOTE: Xref layers no longer display in Properties and are grayed out in the Layer drop-down list (since you can’t pick them anyway!).

PDF enhancements
You’ll find the updated PDFs in AutoCAD 2016 are slimmer and faster! More font types (including SHX) are fully supported. That means that more text can be highlighted, copied, and searched.

Export to DWF™ and Export to PDF options have been split, and they each have their own Export Options dialogs.

New PDF export options for hyperlinks and bookmarks have been added.

Four different predefined PDF options can be found when plotting, so you can easily select the one to suit your needs.

Layout names are automatically displayed as page labels in the PDF file (much easier to identify sheets!).

NOTE: Xref layers no longer display in Properties and are grayed out in the Layer drop-down list (since you can’t pick them anyway!).

TIP: Use hyperlinks to link sheets, named views, external websites, and files (or from objects such as images, blocks, fields, etc.).
3D Modeling

The Section Plane tool, which creates a cutting plane through 3D objects, now works on point clouds.

Slice generates a thin cut through the model with parallel front and back section planes. It has a thickness property (but no jogs allowed!).

Choose between a simple cutting plane, a slice (new), or a bounded or volumetric area for your section object type.

The new contextual Section Plane tab is filled with more section plane controls, including a Live Section toggle, the ability to add jogs, generate section blocks from solids, and extract section lines from point clouds.

Reality Computing

More and more people are incorporating scans into their designs. Autodesk® ReCap™ software makes working with 3D laser scans a breeze!

**Autodesk ReCap**

Use Autodesk ReCap to convert scan file data from a variety of popular formats to a high-speed point cloud that can be viewed and edited in AutoCAD and other products (including Autodesk® Revit® and Autodesk® Inventor® software).

*NOTE* Autodesk ReCap is a separate application that is installed with AutoCAD 2016 (by default).

Access Autodesk Recap or attach a ReCap point cloud (RCP and RCS) from the Insert tab on the ribbon.

Use the Attach Point Cloud dialog to select the file, scale, insertion point, and rotation angle (and to display valuable data about your point cloud).
The contextual ribbon will switch to a Point Cloud tab when a point cloud is selected.

Display
Now you can increase the point size to visually fill in gaps. Use the Level of Detail slider to set the density for all point clouds.

**NOTE** Use Options ➜ 3D Modeling tab to control the maximum points displayed on the screen for your point clouds. AutoCAD 2016 supports up to 25 million points!

**Section Planes**
A new Section Plane drop-down has been added to the ribbon.

**NOTE** The initial size and position of a section object is based on the extents of the visible 3D objects in the drawing.

Use the new Extract Section Lines tool to generate section lines from a point cloud (when live sectioning is on).

**TIP** Use the Preview result option to make sure you get the desired results (Create can take some time, depending on the number of points analyzed!).

Point clouds now support transparency (making it easier to see your geometry).
**Dynamic UCS**

The handy to use Dynamic UCS tool now works on point clouds! Just make sure Dynamic UCS is turned on and all the point cloud object snaps are turned off. Pass your cursor over a point cloud face and begin drawing!

**NOTE** The point cloud must include segmentation data (indicated in the Properties Palette).

---

**Point Cloud Object Snaps**

Control the point cloud object snaps from the 3D Object Snap tab of Drafting Settings. New osnap modes include Intersection, Edge, Corner, Perpendicular to Edge, and Centerline!

- Use the Intersection object snap to snap to the apparent intersection of two lines of a sectioned point cloud.
- Edge snaps to the edge of two intersecting planes.
- Corner snaps to the corner of three intersecting planes.
- Use Perpendicular to edge to draw perpendicular to the edge of two intersecting planes.
- Use Centerline to snap to the centerline of a cylindrical shape.

---

**TIP** Be sure 3D Object Snap is displayed on the Status bar for easy access to the point cloud object snaps.
Point Cloud Cropping
Use the Cropping panel (rectangular, polygonal, or circular) to clip your point clouds. You can continue to crop your point cloud by changing the view.

Now you can save and restore named cropping states.

Cropping states maintain the boundary as well as the visibility of scans and regions.

**TIP** Use command `POINTCLOUDCROPSTATE` to list and delete crop states.

Point Cloud Manager
Use the Point Cloud Manager to work with multiple point clouds. New to AutoCAD 2016: On/Off buttons for scans and regions are always displayed—names are truncated if needed (but displayed in the tooltip).

Annotation
Annotation is an important part of our designs—check out these timesavers!

Text
Single line text remembers the last justification setting!

Bullets and Numbering
Mtext now has automatic bullets or numbering. Begin a line with a symbol, number, or letter followed by one of these symbols: 
, , >, ) >, ]—and then hit the spacebar to create a bulleted or numbered list.

Click the lightning bolt icon for more options.

**TIP** Use Backspace to remove automatic bullets and numbering.

**TIP** Double-click on a point cloud to view the model from its scan position.
Smart Caps Lock
AutoCAD will automatically correct your text (and turn Caps Lock off) if you accidentally had Caps Lock on while you’re holding down the Shift Key.

Match Text
Use the Match tool in the Text Editor ribbon to apply properties of selected text within any Mtext object.

TIP You’ll find the Match tool is sticky! (Use over and over again.)

Sub/Superscript
Highlight the text and use the Superscript/Subscript tools on the ribbon.

Transparent background
The transparent background in Mtext makes it easy to see objects underneath.

Modify the height and width of columns at the same time with the easy-to-use corner resizer.

Modify them independently by using the arrows on each edge.

AutoStack
It’s easier to AutoStack! Just put a forward slash between numbers like 1/20.

Click on the lightning icon for other stack options.

Text Alignment
The TEXTALIGN command quickly aligns text to existing text (or by selecting points). You can easily control the spacing and alignment direction.
Smart Dimensioning
Let AutoCAD 2016 take the tedium out of dimensioning! The updated DIM command is smart enough to detect objects and provide various visual dimension options.

**TIP** You can even specify a default dimensioning layer (only valid when using the new DIM command).

Use the DIMLAYER command to create a new layer for dimensioning.

Check out the horizontal, vertical and aligned dimension previews when you select a linear object—then simply place the desired dimension. Or select another non-parallel linear object to display and place an angular dimension.

Hover over a circle or arc and preview a diameter or radial dimension—arcs come with the additional option to create an angular dimension.

The default values are automatically assumed for the dimension text and angles resulting in fewer steps (but you can still change them from the right-click menu or command line).

If you attempt to create an overlapping dimension you’ll see options to move, break up, or replace the existing dimension.

And the DIM command remains active until you exit the command, so you can knock out multiple dimensions at one time.

Think of all the time you’ll save!
TIP Use the new width sizing control to wrap dimension text! (One of the many AUGI Wish List items granted!).

TIP No more snapping to extension lines by accident! Object snaps ignore extension lines when creating dimensions (control this behavior in Options).

Rendering

The new rendering engine in AutoCAD 2016 is simpler to use and yields better results.

You’ll find the updated Render panel (Visualize ribbon tab) includes a Render to Size drop-down list.

Select More Output Settings to access the Render to Size Output Settings dialog. Here you can specify the image size, resolution, and format in easily understood terms.

The tooltips provide more helpful details.

Render Presets

Use the Render Presets list to control the render quality (in levels) or how much time it will take to render.

Specify Render in a window, current viewport, or a specified region in the current viewport. Specify the duration and accuracy of the render.

The new Render Presets Manager is much easier to use. Create, modify, and delete custom render presets.
Render Environments
Check out the new image-based lighting (IBL) environments! In the Render Environment and Exposure palette you can automatically apply lighting effects and 360-degree background images.

TIP You can also use a custom background image (but they remain static).

NOTE The viewport or model needs to be in perspective view and you must render in order to orbit around the model.

Render Window
Save a snapshot, zoom while rendering, and print the image in the new Render window.

Expand the window to view the render history.
Now you can attach coordination models to a drawing! The Attach command and the Xref Manager now have options for Autodesk® Navisworks® files (NWD or NWC).

The new Attach Coordination Model dialog contains typical controls such as path type, insertion point, etc.

Selecting the coordination model displays the contextual ribbon tab with options to control the display through fading.

To attach coordination models, you need a 64-bit system and hardware acceleration must be on.

Access your BIM 360 Glue projects directly from AutoCAD by signing into A360 and selecting the project host.

Adjust the color and opacity fading on the contextual ribbon tab.

**NOTE** AutoCAD 2016 automatically loads the latest version of the attached BIM 360 Glue model.

**TIP** You can also attach Navisworks files using the new CMATTACH command.

**NOTE** To attach coordination models, you need a 64-bit system and hardware acceleration must be on.
Autodesk Exchange Apps
Get direct access to downloadable applications and content that can increase your productivity. Simply click on the big X on Infocenter.

Several valuable tools, such as the Featured Apps ribbon tab, the Exchange App Manager, and the SketchUp Import app are automatically installed in AutoCAD 2016.

Security!
AutoCAD 2016 offers extra security controls to help protect your drawings. Set Trusted Locations folders to prevent unauthorized execution of files such as scripts, AutoLISP® files, or VBA applications.

You will find a variety of Security Options on the System tab of Options.

NOTE: Digital signature controls are now accessible via the new DIGITALSIGN command.

Single Service Pack
Now you can install AutoCAD service packs on any AutoCAD 2016 vertical-based product (no need to wait for the integrated service pack anymore!).

Autodesk Application Manager
This desktop tool helps you stay current with the latest updates for all your Autodesk applications. The Autodesk® Application Manager will send you timely messages about service packs, hot fixes, and more.

The Application Manager seamlessly downloads the files from the cloud and installs them for you.
It’s all about the cloud, baby! Connect to your secure A360 account for file sharing, customization syncing, project management, and more.

**A360 Tab**
Use the A360 tab for all things related to your A360 account.

**Share Document**
Makes it easy to save and share your document with others via A360. You provide the email addresses and comments—A360 does the rest!

**Open Local Sync Folder**
Opens the A360 folder your drawing is being synced to.

**Open A360 Drive**
This tool takes you online to your stored documents and folders via browser.

**TIP**
You’ll also find A360 access in many of the Select File dialog boxes.

When you upload drawings from AutoCAD to A360, external references and other dependent files upload as well!

**Settings Sync**
Be sure to set up your cloud settings to control when your design data and custom settings are synced. Choose to automatically store your design data each time you save, or only when you specify.

**Choose Settings**
Choose which settings you’d like A360 to automatically sync.

**Sync My Settings**
We all set up AutoCAD to work the way we like to work! Now you can save and sync those settings with A360. Save your program appearance, profiles, tool palettes, customization files, Options, and support files to A360 so you can restore them onto any computer!
TIPS AND TRICKS

Have you tried Autodesk® AutoCAD® 360 web app yet? AutoCAD 360 lets you view, edit, and share drawings through the web or mobile device (take your drawings on the road!).

Collaborate with others on the same drawing in real time! Use the basic editing features to mark up a drawing file. Use the Timeline tool for a detailed design history.

Give AutoCAD 360 a try—did I mention it’s free*?

Download the free* app for iOS mobile devices at the App Store. Also available for the Android.

It’s easily accessed from inside AutoCAD via the A360 tab, or visit www.autocad360.com today!

AutoCAD Subscription Options

Desktop Subscription
Enjoy access to the latest software releases, technical support, flexible licensing, and a variety of A360 cloud benefits.

Maintenance Subscription
Maximize the value of your perpetual license with the latest upgrades, flexible licensing, technical support, and access to select cloud and software services.

Cloud Service Subscription
Extend your workflow to the cloud for virtually infinite computing power, collaboration tools, and access to your files and software—almost anytime, anywhere.
TrustedDWG Technology

Not All “.dwg” Files Are Created Equal
You’ve invested thousands, if not tens of thousands, of dollars in developing your designs. Help retain the integrity of your design data throughout the review process with TrustedDWG™ technology.

Built into AutoCAD, TrustedDWG is the original and most accurate way to store and share DWG™ files. TrustedDWG files are created using a complete technology that maintains each element in a drawing, and the relationship between elements, with data fidelity.

With over 30 years of technology wrapped up in every TrustedDWG file, it helps you preserve and protect your invaluable designs.

AutoCAD Design Suite

Autodesk® AutoCAD® Design Suite includes AutoCAD, plus tools to help you capture design information and showcase your work:

- Autodesk® AutoCAD® Raster Design
- Autodesk® Showcase®
- Autodesk® 3ds Max® (Available in Premium)
- Autodesk® Alias® Design (Available in Ultimate)
AutoCAD Raster Design
Get more value from your raster imagery (such as scanned drawings, maps, and aerial photos). Valuable Raster to Vector Conversion including Optical Character Recognition (OCR) gives you accurate results when you create lines and polylines from raster data.

Showcase
Quickly and easily transform your AutoCAD designs into compelling imagery, movies, and interactive presentations for design reviews and sales pitches.

3ds Max
(Available in Premium)
Create cinematic-quality 3D visuals with animation, character, effects, and point-and-shoot rendering and lighting analysis tools.

Alias Design
(Available in Ultimate)
Enjoy a range of sketching, modeling, surfacing, and visualization tools with industrial design and Class-A surfacing software.
Lynn Allen, Cadalyst columnist and worldwide Autodesk Technical Evangelist, speaks to more than 30,000 users each year. For the past 23 years she has written a column in Cadalyst magazine called “Circles and Lines” and is the voice behind Cadalyst’s “Tips and Tricks Tuesdays.” Lynn started using AutoCAD software with Release 1.4, over 25 years ago, and got her start by teaching at the corporate and collegiate level for 12 years. A sought-after public speaker with a unique comedic style, Lynn has served as the Autodesk University host for more than 10 years and is always one of the highest-rated speakers. Her latest book is entitled *AutoCAD Professional Tips and Techniques.*

*Free Autodesk software and/or cloud-based services are subject to acceptance of and compliance with the terms and conditions of the license agreement or terms of service, as applicable, that accompany such software or cloud-based services.*

Autodesk, AutoCAD, Autodesk Inventor, the Autodesk logo, AutoLISP, Alias, AutoCAD 360, BIM 360, Glue, Inventor, Navisworks, ReCap, Revit, Showcase, TrustedDWG, and 3ds Max are registered trademarks or trademarks of Autodesk, Inc. and/or its subsidiaries and/or affiliates in the USA and/or other countries. All other brand names, product names or trademarks belong to their respective holders. Autodesk reserves the right to alter product and services offerings, and specifications and pricing at any time without notice, and is not responsible for typographical or graphical errors that may appear in this document. © 2015 Autodesk, Inc. All rights reserved.